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Total points (7]

STUDENT NAME *

VIVA

v~ 1. Which of the following switching does the internet use? * 1/1

1. Sexqe R g 7 O g g o1 Iuan fear s g2
@ 1. Packet switching V4
() 2. Circuit switching

O 3. Telephone switching

() 4. Telex switching

v/ 2. Which of the following is a graphical package? * 1/1
2. FEfafed o ¥ &1 91 Te Tt Udhel 62

@ 1. CorelDraw v
() 2. Microsoft Excel
() 3. Microsoft Word

() 4. Microsoft Access



<~ 3. The content of the disk that is recorded at the time of manufacture and *1/1
that cannot be changed or erased by the user is

3. %wwaga%awwm%%ﬁﬁﬁm%wm P P TG
I ToR gRT SIaRT Sedl 31 fer T8t o Gl 82

@ 1. Read-only v
O 2. Memory-only
(O 3.Run-only

() 4. write-only

v/ 4. ACD-RW disk: * 1/1
4. FgH 7 cD-RW f$%b Bl Ueb fa=ivie 82
() 1.has a faster access than an internal disk.

() 2.isaform of an optical disk, so it can be written once.

O 3. holds less data than a floppy disk.

@ 4. can be erased and rewritten. v

v/ 5. Virtual memory is . * 1/1
5. g3 TR T §?

@ 1. a memory on the hard disk that the CPU uses as an extended RAM v

() 2.aROM

O 3. only necessary if you do not have any RAM in your computer

O 4. a backup device for floppy disks



v/ 6. By using which tab can you update fields in OpenOffice writer? *1/1
6. 3T AT IR (OpenOffice writer) A l.bnlcs\H P 3T B & forw
9 & 3 ooy ¢a o1 Ui foran o e 82

() 1.View

O 2. Format

v© 7. is a light-sensitive computer input device. * 1/1

7.9 D I U UHRI-HAd dEeR 3Yc fEarsy 82

() 1.MICR

@ 2. Light Pen v
O 3. Scanner

() 4.0MCR

v’ 8. can digitise full motion and still images. * 1/1

8. g O ¥ a wifoRfier ok RR Al & yofa: feforess &R awdar g2

() Plotter
() 2.Speaker

() 3. Microphone

(® 4. Digital Camera v



<~ 9. Which function counts non-blank cells in a database in MS-Excel? *1/1
9. MS Excel &1 7 & § &1 T1 hhaRM Sere # 4R U (non-blank) I Bt
T HRAT 872

() 1.COUNTNC function
(® 2. COUNTA function v
() 3.DCOUNTNC function

() 4.DCOUNTCELL function

v, 10.A card is an expansion card that generates a feed of output *1/1
images to a display (such as a computer monitor).
10.ﬁ§ﬁ@faﬁqum(expansion)m %Gﬁﬂwsﬁﬁﬁ s
! frdfl foeat (S e A1 eR) R Tefid adr g2

() 1.sound
@ 2. video v/

(O 3. network interface

() apcC

v/ 11. Which of the following software rearranges files so that all parts of  *1/1
the files are next to each other?
11. T 9 & 91 I IR BIEdl &1 39 YHR e ard $Hdl &, o
HIgdl & JUT 3R Teh-g T o U I3 ?

@ 1. Disk defragmenter v
() 2.Backup
() 3. File Synchronization

() 4. Scheduling



v'© 12 is the scanning of paper to detect the presence or absence *1/1
of a mark in a predetermined position.

12. T TR R fordd! farg @1 fordd! g -Feffed fufa ot SufRufaan sraafufa
BHIUAT A &b T, SYUR BT BT B S 2

v/ 13. Parallel ports are often referred to as ports. * 1/1

13. qAIRUCHIU™: UG h YA AT gl

v, 14.A is a portable storage device that connects to a *1/1
computer via a USB port.

14. FFg A 9 1 I 98 Nidad ©Rel fgarga g S USB UIE &1 IgradT I
SR Y31 el 87

® 1. flash drive v
() 2.pvD
() 3.cD

() 4. motherboard



v 15. Which of the following is NOT a name of 1D Barcode font? * 1/1

15, RfIfad § A &9 7 1D IRBIS Bi< BT T TTH Tl 82

@ 1. Bookland v

() 2.Interleaved 2 of 5
(0 3.Codabar

() 4.CODE 128

v/ 16.In MS-Word which keyboard shortcut is used to open a document *1/1
16. MS-Word ¥ , SiegHcH &I WieH o fog forg &1 aTs RMicane &1 WanT
o ST 82

(O 1. shift+0
() 2 Alt+0
() 3.Ctrl+N
@® 4.ctri+0 v
v/ 17. A printer's speed determines its: * 1/1

17. T e o Wits 39! /39% EEIEGERGIN

() 1.cost

@ 2. number of pages printed per minute v

() 3.brand

O 4. quality



v 18. Which among the following MS-Excel function converts a serial *1/1
number to a minute?

18. Fgfafad & @ HH-91 MS-Excel R Te HIRTd FeR &) T e #
gRkafdd wedr g2

() 1.MIN
® 2. MINUTE v

() 3.MINA

() 4. MINVERSE

v 19. Which of the following printers is an impact printer? * 1/1
19. HH-97 fifex 39e fifeR &2

O 1. Laser printer

O 2. Ink jet printer

(O 3.Thermal printer

@ 4. Dot matrix printer v

v 20. Which of the following is a printer language? * 1/1

20. fFuH @ H-3t, T fliex 1T 82

@ 1. PostScript v
O 2. Prescript
O 3. Scripting

() 4 HTML



v/ 21.In MS-Word, which keyboard shortcut is used to center the text? *1/1
21. MS-Word H , CRe &1 A&l (Yer) H B & ot ford &1 &1 Wicdhe &1
ST faa S 62

@® 1.ctri+E v

() 2.Shift+E

() 3.Al+E
() 4.ctrl+F

v~ 22.In MS-Excel, which function returns the annual nominal interest rate * 1/1

22. MS-Excel # , ®19-TT (aR dTf¥ep TIEel TSl & eAleldl 8?2

() 1.NORM
(® 2. NOMINAL v

() 3.INT

() 4. INTEREST

v/ 23.In MS-Word, which keyboard shortcut is used to align the text tothe  *1/1
right?
23. MS-Word &, ToRe &1 &Ts 3R TRRA A & foTd b &1 s icdhe dl
ST {321 STl 52

(O 3.shift+R

() 4.ctr+A



v/ 24. Which of the following is NOT a networking device? *

24. 390 Q HI-41, edie] fgagy T8l 872

O 1. Gateway

() 2. Firewall

@ 3. Linux

O 4. Router

v/ 25. Laser printer uses ink. *

25 AR filer __ TIEt BT T AT g |

() 1. powdered white
@ 2. powdered black

O 3. powdered gray

() 4. powdered RGB

v/ 26. What does the image type "GIF" stand for? *
26. BTd UHR T "GIF" T RT3 572

@ 1. Graphics Interchange Format
() 2. Graph Interchange Format
() 3. Graphics Internal File

O 4. Graphics Internal Format

1/1

11

11



v/ 27.Which of the following are the block cipher modes of operation? * 1/1

27. U B Q H-91, ITRIM BT Alh TSR AIS 87

(O 1.PCMC, PCBC, ECB, RBC
() 2.EBC,RBC, CBC, CFB
(® 3.ECB, CBC, CFB, OFB, CTR v

O 4. PCMC, PCBC, ECC, RBC

v 28.1In Excel, in which category does NORMSDIST function belong to? * 1/1
28. Excel ¥ , NORMSDIST TraRr farg 90Tt F {1l 87

@ 1. Statistical v

O 2. Compatibility

v~ 29.In Microsoft Word, Ctrl +
document
29. Microsoft Word ff, Ctrl +

PIC |

will cut selected text from your Word *1/1

3% g8 SlagHc J TIMd CRe &l

(O 1.F



v~ 30. What are swells? * 1/1

30. W& (swells) TG ?

@ 1. Short-term increases in voltage levels v
() 2.Huge, sudden increases in voltage levels
() 3.Short decreases in voltage levels

() 4. Complete loss of electricity

v~ 31. Which of the following is a URL? * 1/1

31. AU H QA P I TPH URL 872

(O 1. mkclindi@mkel.org

@ 2. www.gmail.com v

(O 3. Microsoft Edge

() 4. Firefox

v'© 32 is a free service from Google that allows you to store files  *1/1
online and access them anywhere using the cloud.
32. ,TTE &1 T : Yoob a1 § SN SATUD! Bl Bl AR €R

A 3R FATIS BT STUNT FRb gl I Hi I TR B B A St g

() 1. Microsoft Word
() 2.Google Slides

@ 3. Google Drive v

() 4. Paint


mailto:mkclindi@mkcl.org
https://www.google.com/url?q=http://www.gmail.com&sa=D&source=editors&ust=1747298294263448&usg=AOvVaw0e8JGKI3qIBB12srD5zjRG

v 33. Which of the following is NOT required to start BHIM? * 1/1
33. BHIM URY & & fore Fufoiaa & 9 frae! siawadar 761 82

() 1. Smartphone with internet access and an Indian bank account.
() 2. Smartphone with internet access.
() 3. Smartphone with Indian bank account.

@ 4. Foreign Bank account v/

v 34. Accepting and rejecting any change in the Microsoft Word document *1/1
is a part of process.

34. Microsoft Word Siagdc # farat Hft uRacd &1 WeR a1 SRATePR AT
___ vfrowius fewmn gl

@ 1. reviewing v
() 2. formatting
() 3.recording

() 4. deleting

v/ 35. How many number of small letters are there when we use the toggle *1/1
case option in the change case list of Microsoft Word?

35. Microsoft Word &1 ool o Il ¥ Td g4 THIl b [ddhed &bl SUTNT
A g, Al ITH fora BIC R ANE Bl § 2

() 1.Remains the same
@ 2. As many as the capital letter before applying the change case v
() 3.0nlyone

() 4. zero



< 36.Whatis a font size? * 1/1
36. Bl P PR Y T Ay 82

() 1.1tis defined as the collection of all fonts.
@ 2. It is defined as in points which are equivalent to pixels on computer displays. «/
() 3.Itis defined as a set of characters.

() 4.1t characterizes by weight.

v/ 3. Which parameters are included in the decorative classification of *1/1
fonts?

3. oIy & Foltac! qexur 8 A5 § 9 S J IR A g & 2
@ 1. Graffiti, grunge, psychedelic v
O 2. Formal, casual, calligraphic, blackletter and lombardic

O 3. Psychedelic, grunge, casual, formal

O 4. Formal, casual, calligraphic, geometric



v 38. Following are the steps to format the line spacing in Microsoft Word. *1/1
Arrange them in a sequence.
a) Click the Line and Paragraph Spacing command in the Paragraph
group on the Home tab.
b) Select the desired spacing option from the drop-down menu.
c) Select the text you want to format.

38. Microsoft Word H , @181 TR &) WiHe &1 & TRur = fey e g,
3% e % H afyd S|

a) B ¢ & IRIU% U H A8 U8 RAME WRIT HHis WR faaes Sifon|
b) S1U-813 T ¥ Tifesd WRIT f[dehed &1 aa HIT|

c) Wife fHd S aTd TRe &1 T &1 fS7u|

v 39.In Excel,
cell

39. Excel H, D1 IuANT fobfl T T Iy S a1 G S AR
A & fore fpar a8

is/are used to add a note or explain a formula in a *1/1

@ 1. Comments v

() 2.Show Ink
() 3.Insertions and Deletions

O 4. Markup area highlight



<~ 40. Microsoft Excel file is saved with the file extension. *1/1
40. Microsoft Excel BISA @I, I3 UGS & 91 4 fobam Srdm

gl

@ 1. xIsx v

() 2..bmp
() 3..docx
O 4. pptx

v/ 41.In Mail Merge,
form of fields.

41. 9 TSl (Mail Merge) &, 93t afvad-a SHa1al hics & U H,
_ HANERdRE

contains all the variable information in the *1/1

(O 1.envelope

() 2. form label
@ 3. address book v

() 4. main document

v/ 42. The first page that you visit in a website is called the page.* 1/1
42. T4l ISTSC HT UGl U 1 Hgardl g2

(O 1.Middle

() 2. Last

@ 3. Home v

O 4. Master



v/ 43.Ildentify the statement that is False for symmetric DSL * 11
43. 39 HYA PI Ugd ot AT DSL & g Tad |

() 1.They have the same download and upload rates.
() 2.There are no internet bottlenecks.
O 3. You can upload file and update at the same time.

@ 4. These connections are almost always less expensive v

v/ 44. Which keyboard shortcut is used to hide and unhide the ribbon in *1/1
Microsoft Excel?

44. Microsoft Excel ﬁ%ﬁﬁﬁﬁ@??ﬂﬁ%%ﬂﬁ?ﬁﬁmﬁ@é
TNcdhe B IGANT fhaT ST 82

() 1.ctrl+F5
@® 2.ctrl+F v
() 3. Alt+F4
() 4 At+F9
v 45. In Microsoft Excel, the keyboard shortcut inserts a new row. *1/1

45. Microsoft Excel ﬁ,w%ﬁ%mﬁ%ﬁﬁyﬁ@rmﬁaﬁé
TNicdhe B ITANT fhaT STaT 82

() 1. Alt+R

® 2. cCtrl + Shift ++ v
() 3.ctrl+Shift+R

() 4.ctl+Alt+N



v/ 46. chart in Microsoft Excel plots two groups of numbers as one  *1/1
series of XY coordinates.
46. Microsoft Excel ®T_____ dTc, TAT3N & &l THg! & XY Faiie! &
TH 4@ & ¥ & Wic aal gl

O 1. An area
() 2.Apie
@ 3. A scatter v

() 4. Astock

v 47.Which of the following is NOT a chart element in Microsoft Excel? * 11

47. Fafafad & 9 B9 AT Microsoft Excel &7 T dT¢ Tfaie gl 82

() 1. Axis titles
() 2. Data labels
() 3.Errorbars

@ 4. Progress marker v

v 48.In Microsoft Excel, to replace a word with another word, selected from *1/1
a list of words with the same meaning, the option may be used.

48. Microsoft Excel ff, a7 37 arl QI@'aﬁﬁﬁﬁ@[ﬂe{WWWﬁ
G Teg Y IGaH & faTg, fqsed o1 SUTNT foaT ST adhdT g |

() 1.Language
O 2. Spelling and Grammar

(® 3.Thesaurus v

() 4. Translate



v 49.To convert a Microsoft Excel file to CSV format, which of the following *1/1
steps must be taken?

49. Microsoft Excel BT8d &1 CSV BiHc # URdfdd o+ & fore Fafefad o
Y o RO &1 IYTRT fobar ST @1 w?

() 1.File > Export
() 2.File->Import

() 3.File—>Save

@ 4. File --> Save As N4

v 50. In Microsoft Excel, a is a special graphic object that includes  *1/1
text within a rectangular graphic object.

50. , MS-Excel 1 U 3R ifthap 3ifsoiae § foras T
WWW%%WW@W%

(O 1.cClip Art

() 2. Gridline

@ 3. Text Box v

() 4. Word Art

v~ 51.To freeze an area of cells in a Microsoft Excel worksheet, the
option may be used.
51. Microsoft Excel Wﬁ,@ﬁ%% aaﬁuﬂamﬁém o
fadhed BT SUTNT fohaT off TahelT g |

*1/1

() 1.Freeze Block
() 2. Freeze Cells
@ 3. Freeze Panes v

() 4. Freeze Table



v/ 52.In Microsoft Excel, the
is spelt incorrectly.

52. Microsoft Excel &, TR dq 3{1dT €, 9 W= & ATH & WfeRTed
RG]

error may occur when a function name  *1/1

® 1. #NAME? v

() 2. #NuLL!
() 3.#N/A

() 4. #REF!
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